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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

MCP19117 Flyback Stand-Alone Evaluation Board. Items discussed in this chapter 

include:

� Document Layout

� Conventions Used in this Guide

� Recommended Reading

� The Microchip Web Site

� Customer Support

� Document Revision History

DOCUMENT LAYOUT

This document describes how to install the MCP19117 Flyback Stand-Alone Evaluation 

Board. It also describes how to operate the Evaluation Board. The manual layout is as 

follows:

� Chapter 1. “Product Overview” – Important information about the MCP19117 

Flyback Stand-Alone Evaluation Board.

� Chapter 2. “Installation and Operation” – Includes instructions on how to get 

started with the MCP19117 Flyback Stand-Alone Evaluation Board.

� Chapter 3. “Graphical User Interface (GUI) Features” – Includes instructions 

on the MCP19117 Flyback Standalone GUI.

� Appendix A. “Schematic and Layouts” – Shows the schematic and layout 

diagrams for the MCP19117 Flyback Stand-Alone Evaluation Board.

� Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 

MCP19117 Flyback Stand-Alone Evaluation Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 

Select the Help menu, and then Topics to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 

[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 

var_name...]

Represents code supplied by 

user

void main (void)

{ ...

}
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RECOMMENDED READING

This user's guide describes how to use MCP19117 Flyback Stand-Alone Evaluation 

Board. Other useful documents are listed below. The following Microchip documents 

are available and recommended as supplemental reference resources.

� MCP19116/7 Data Sheet – “Digitally Enhanced Power Analog Synchronous 

Low-Side PWM Controller” (DS20005479)

� MPLAB® X IDE User Guide – “PICkit™ 3 In-Circuit Debugger/Programmer 

User’s Guide For MPLAB® X IDE” (DS52116)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

� Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

� General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

� Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

� Distributor or Representative

� Local Sales Office

� Field Application Engineer (FAE)

� Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 

http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (March 2016)

Initial Release of this Document.
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Chapter 1.  Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP19117 Flyback Stand-Alone Evaluation 

Board and covers the following topics:

� MCP19117 Short Overview

� What is the MCP19117 Flyback Stand-Alone Evaluation Board?

� MCP19117 Flyback Stand-Alone Evaluation Board Kit Contents

1.2 MCP19117 SHORT OVERVIEW

The MCP19117 is a highly integrated, mixed-signal, analog pulse width-modulation 

(PWM) current mode controller with an integrated microcontroller core, and offers syn-

chronous or asynchronous operation. Since the MCP19117 device uses traditional 

analog control circuitry to regulate the output current or voltage, the integration of the 

PIC® microcontroller mid-range core is used to provide complete customization of the 

device’s operating parameters, protection levels, programmable offset, dead-times, 

slope compensation and fault handling procedures.

The MCP19117 has two internal low drop-out regulators (LDOs). A 5V LDO (VDD) pro-

vides internal power to all the digital circuitry and can supply limited external power at 

the VDD pin. A 4V LDO (AVDD) provides power to the internal analog circuitry and sup-

plies the reference voltage to the ADC. This device features synchronous low-side inte-

grated drivers and 8k Words non-volatile memory, all in a space-saving 28-pin 5x5 mm 

QFN package. 

To support traditional MOSFETs, pin 20 (VDR) is used to provide input power to the two 

low-side synchronous gate drivers. The evaluation board is populated with the 

Microchip TC1240AECHTR voltage doubler. Resistor population provides the option of 

powering VDR with 10V through the TC1240AECHTR voltage doubler (R19, R21 

populated; R22 not populated) or 5V (R22 populated; R19, R21 not populated) 

gate-drive capability.

User firmware, including device configuration, is loaded using Microchip’s MPLAB® X 

Integrated Development Environment (IDE). A graphical user’s interface (GUI) is used 

to communicate with and edit operating parameters of the MCP19117. The GUI com-

municates via I2C using the PICkit™ Serial Analyzer. 

The GUI offers the user the ability to adjust the programmable features available in the 

MCP19117. Note that the interface cannot stop the user from uploading incorrect set-

tings to the device. Incorrect settings may have unintended consequences, including, 

but not limited to, unstable operation, damaging the load, and even damaging of the 

MCP19117 device. It is the user's responsibility to understand the system effects of the 

parameters they enter.
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1.3 WHAT IS THE MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD?

The MCP19117 Flyback Stand-Alone Evaluation Board is intended to 

demonstrate how the MCP19117 device operates in a synchronous flyback 

topology. It is configured to regulate load current and is also well-suited to drive 

LED loads. Nearly all operational and control system parameters are 

programmable by utilizing the integrated PIC Microcontroller core. 

The MCP19117 Flyback Stand-Alone Evaluation Board is delivered 

preprogrammed with firmware designed to operate with the GUI interface. 

MPLAB X IDE software can be used to download user-defined firmware, thus 

tailoring it to their specific application.The evaluation board contains headers 

for In-Circuit Serial Programming™ (ICSP) as well as I2C communication. 

Several test points have been designed into the printed circuit board for easy 

access and development purposes. The MCP19117 Flyback Stand-Alone 

Evaluation Board is also intended to demonstrate an optimized printed circuit 

board (PCB) layout that minimizes parasitics while increasing efficiency and 

power density. Proper PCB layout is critical to achieve optimum MCP19117 

operation as well as power train efficiency and noise minimization. The 

MPLAB X IDE, MCP19117 Flyback Standalone GUI and MCP19117 Flyback 

Stand-Alone firmware are available for download from Microchip’s web site. 

See Chapter 3. “Graphical User Interface (GUI) Features” for details.

1.4 MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD KIT CONTENTS

The MCP19117 Flyback Stand-Alone Evaluation Board includes the following 

items:

� MCP19117 Flyback Stand-Alone Evaluation Board (ADM00663)

� Important Information Sheet
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Chapter 2.  Installation and Operation

2.1 ABOUT THE MCP19117 FLYBACK STAND-ALONE EVALUATION BOARD

The MCP19117 is a digitally-enhanced, power analog, synchronous low-side PWM 
controller. The GUI was developed to assist users in easily configuring the MCP19117 
and evaluating it in their target application.

The MCP19117 Flyback Stand-Alone Evaluation Board is designed to operate from a 

single supply (nominal 8V to 14V, 24V maximum). The primary side MOSFET has a 

maximum VDS rating of 100V. Users should be cautious that this 100V rating is not 

exceeded when determining input and output conditions for their application. The 

coupled inductor has a 2:1 ratio. The secondary MOSFET has a 200V maximum VDS 

rating.

The default configuration provides the gate drive supply (VDR) with 10V. Adequate 

ceramic and bulk capacitors are supplied on the input to reduce the root mean square 

(RMS) ripple current and lessen input voltage deviation caused by load transients. 

Ceramic capacitors are also provided on the output to reduce voltage ripple and 

provide energy to the output while the primary side is being re-energized.

The MCP19117 Flyback Stand-Alone Evaluation Board is fully assembled, pro-

grammed and tested to evaluate and demonstrate the MCP19117 operating perfor-

mance. Users will need to download and install the MCP19117 Flyback Standalone 

GUI from the Microchip website and become familiar with its operation before powering 

the MCP19117 Flyback Stand-Alone Evaluation Board.

2.2 SYSTEM AND CONFIGURATION REQUIREMENTS

To power-up and run the MCP19117 Flyback Stand-Alone Evaluation Board, the 

following is required:

� MCP19117 Flyback Standalone GUI 

� MCP19117 Flyback Stand-Alone Evaluation Board

� PICkit Serial Analyzer

For USB connectivity, the minimal physical requirement for the PC is a standard USB 

2.0 port. If the board connects to the PC through a USB hub, use a self-powered hub.

The MCP19117 Flyback Stand-Alone Evaluation Board comes with preprogrammed 

firmware installed to operate with the GUI. To reprogram the device, the following tools 

are required:

� MPLAB X IDE (version 3.05 or later)

� MPLAB® XC8 C Compiler (v1.35 or later)

� MCP19117 Flyback Standalone Firmware

� MCP19117 Flyback Stand-Alone Evaluation Board

� PICkit™ 3 In-Circuit Debugger/Programmer

The MCP19117 Flyback Standalone GUI requires a Microsoft Windows® XP/7/8 

operating system and a minimum screen resolution of 1024 x 768. 

Note: The factory-loaded firmware requires the use of the provided GUI to 

function. Without the GUI, the evaluation board does not operate. 
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2.3 CONNECTING POWER INPUT AND OUTPUT

Use the VIN and GND Test Points as shown below. Nominal VIN is +8V to +14V with 

the Positive terminal (Red) connected to VIN and the Negative terminal (Black) 

connected to GND.

FIGURE 2-1: Applying Power to the Board.

VOUT

GND

GND

VIN

CAUTION

Primary side MOSFET is Rated to 100V. The transformer turns ratio is 1:2. 

Do NOT exceed the 100V MOSFET Rating. Primary MOSFET (OFF) VDS = 0.5 x VOUT + VIN.
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2.4 INSTALLING THE MCP19117 FLYBACK STANDALONE GUI

The MCP19117 comes programmed with generic firmware that is compatible with the 

standalone GUI. It is up to the user to modify or create new firmware dedicated to their 

stand-alone application if different functionality is required. 

Perform the following steps to install the MCP19117 Flyback Standalone GUI:

1. Download the MCP19117 Flyback Standalone GUI software package from the 

Microchip web site. 

2. Extract the content of the archive files on the computer.

3. Double-click the setup.exe file to start software installation. Press the Install 

button in the Application Install window (Figure 2-2). After the installation 

completes, the application window is displayed (as shown in Figure 3-2 of 

Chapter 3. “Graphical User Interface (GUI) Features”).

FIGURE 2-2: MCP19117 Flyback Standalone GUI Installation Window.

Note: If the default firmware is modified, the GUI may no longer be compatible 

with the MCP19117 Flyback Stand-Alone Evaluation Board. 
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2.5 REPROGRAMMING THE MCP19117 FLYBACK STAND-ALONE EVALUATION 
BOARD

Perform the following steps to install necessary software and begin reprogramming the 

MCP19117 device:

1. If MPLAB X IDE is already installed, go to Step 2. If not, download MPLAB X IDE 

from: www.microchip.com/mplabx, and follow the installation instructions.

2. If the MPLAB XC8 C Compiler, or a compatible equivalent, is already installed in 

MPLAB X IDE, go to Step 3. If not, you can download a free version of the 

MPLAB XC8 C Compiler from: www.microchip.com/mplabxc. The user guide, 

installation instructions, and download links are available on the web page.

3. Download the MCP19117 - Flyback Stand-Alone Firmware 

(ADM00663_02_10403_U1-R2_Firmware.zip) from 

www.microchip.com/mcp19117 under "Documentation".

4. Unzip the MCP19117 - Flyback Stand-Alone Firmware archive. Place the 

MCP19117 project folder in the desired folder location. 

5. Power-up the MCP19117 Flyback Stand-Alone Evaluation Board.

6. Connect the PICkit 3 In-Circuit Debugger to the MCP19117 Flyback Stand-Alone 

Evaluation Board via the 6-pin connector J3, as seen in Figure 2-3. For more 

information about PICkit 3 In-Circuit Debugger refer to the PICkit™ 3 In-Circuit 

Debugger/Programmer User’s Guide For MPLAB® X IDE (DS52116).

FIGURE 2-3: PICkit 3 In-Circuit Debugger/Programmer Connected to the 

MCP19117 Flyback Stand-Alone Evaluation Board.

Note: When installed, MPLAB X IDE automatically creates a project folder. In 

Windows, this folder is typically located under 

drive\Users\user_name\MPLABXProjects.
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7. Open MPLAB X IDE to load the MCP19117 Flyback Stand-Alone firmware. From 

the File menu select Open Project (Figure 2-4).

FIGURE 2-4: Opening Project in MPLAB X IDE.

8. Browse for the location of the extracted firmware. Select the 

MCP19117_Stand_Alone from the list, then check the Open as Main Project 

option. Click the Open Project button to complete loading the file.

FIGURE 2-5: Loading Firmware into MPLAB X IDE.
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9. When the project is open, click the Make and Program Device Main Project button on the tool bar 

to program the device. Wait until the program process is complete (see Figure 2-6).

FIGURE 2-6: Selecting and Executing the Make and Program Device Main Project in MPLAB X 

IDE.
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Chapter 3.  Graphical User Interface (GUI) Features

3.1 ABOUT THE MCP19117 FLYBACK STANDALONE GUI

This chapter describes the steps that are required to launch the MCP19117 Flyback 

Standalone GUI.

3.1.1 Prerequisites

Prior to starting the GUI, perform these actions:

1. Apply an input voltage in the normal operating range (8V to 14V) at the VIN and 

Ground test points.

2. Connect the PICkit Serial Analyzer to the PC through USB port and then connect 

the analyzer to the Control Board via the 6-pin serial connector J5 (Figure 3-1).

FIGURE 3-1: PICkit Serial Analyzer Connection to the Board.
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3.1.2 Launching the GUI

To start the GUI, select Start > All Programs > Microchip Technology 

Inc. > MCP19117 FLYBACK_STANDALONE_GUI. 

The interface detects the MCP19117 device automatically and is ready for use (see 

Figure 3-2).

FIGURE 3-2: MCP19117 Flyback Standalone GUI - Initial Screen.
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3.2 MCP19117 FLYBACK STANDALONE GUI DESCRIPTION

As depicted in Figure 3-2, the MCP19117 Flyback Standalone GUI is divided into five 

areas: 

� System Parameters Area 

� Advanced Register Update Area

� Register Online Adjust Area

� Control Buttons Area

� Operating Status Box Area

3.2.1 System Parameters Area

The following sections are available in the System Parameters Area

� Drivers Enable/Disable Section

� Operating Mode Section

� Parameters Section

� Protection Section

� Switches Enable/Disable Section

� Test Pin Section

3.2.1.1 DRIVERS ENABLE/DISABLE SECTION

The “Drivers Enable/Disable” section contains an “ON” and an “OFF” check box. If the 

“OFF” check box is selected (default), the system turns off the Primary and Secondary 

Drivers and all the sections in the MCP19117 Flyback Standalone GUI become read 

only. In order for the sections to become editable, select the “ON” check box. 

3.2.1.2 OPERATING MODE SECTION

The “Operating Mode” section controls how the Flyback converter operates. Options 

are:

� Quasi-resonant: the controller will run Quasi-resonant mode and the switching 

frequency will vary depending on the operation conditions.

� Fixed Frequency: the switching frequency parameters are adjustable. By default, 

the check box is selected.

FIGURE 3-3: Operating Mode Options.

This section also contains a selection named Synchronous Operation. When the ON 

check box in the Drivers Enable/Disable section is selected, the Synchronous 

Operation check box is automatically selected – setting the MCP19117 Flyback 

Stand-Alone Evaluation Board to function in Synchronous mode.

If the Synchronous Operation check box is cleared, the evaluation board is set to 

function in Asynchronous Operation mode, which disables the secondary driver 

(SDRV).
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3.2.1.3 PARAMETERS SECTION

This section controls the Switching Frequency, Maximum Duty Cycle, Output Current 

and Current Sense Resistor parameters, as shown in Figure 3-4  

FIGURE 3-4: Parameters Options

The switching frequency is user programmable in Fixed Frequency mode over the 

range of 60 kHz to 1 MHz. Switching Frequency can be adjusted in 10 kHz intervals. 

The maximum duty cycle is programmable from 0 to 100%.
 

The Output Current can be adjusted within a range of 0 to 500 mA. The Current Sense 

Resistor (R6) value on the MCP19117 Flyback Stand-Alone Evaluation Board is 

200 m. Both of these values are used to calculate the set point value written to the 

VREFCON register. Do NOT raise the resistor value in the GUI without changing the 

resistor on the evaluation board to match. Failure to do so could result in damage to 

the evaluation board.

CAUTION

Increasing switching frequency results in increased switching losses in the MOSFETs. 

It is the user's responsibility to ensure that the MOSFETs are operated within their safe 

operating range.

Note: Attempting to write a value larger than 0xFF to VREFCON is prohibited by 

the GUI.
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3.2.1.4 PROTECTION SECTION

The “Protection” section (see Figure 3-5) allows the user to set levels for the three 

adjustable protection features: 

� Enable Input OVLO: specified range of 9V to 24V. The default setting is 18V. This 

parameter is configurable per its specified range.

� Enable Input UVLO: specified  range is 4V to 20V. The default setting is 8V. This 

parameter is configurable per its specified range.

� Enable Output OVLO: configurable range between 0V and 60V. The default 

setting is 40V. 

FIGURE 3-5: Protection Options.

In order for the user to be able to set different values, the corresponding check boxes 

of the features must be selected. Otherwise, the protections are not applied.

The LED (marked with D2) on the evaluation board is used to indicate various fault 

conditions. The firmware will flash this LED to indicate each of the following fault 

conditions:

� VIN UVLO FAULT: Short Flash Routine

� VIN OVLO FAULT: Long Flash Routine

� OUTPUT OV FAULT: Short/Long Flash Routine

3.2.1.5 SWITCHES ENABLE/DISABLE SECTION

There are two general purpose MOSFET low-side series switches located on 

MCP19117 Flyback Stand-Alone Evaluation Board (LSW1 and LSW2). The check 

boxes named “Switch 1” and “Switch 2” in the Switches Enable/Disable section of the 

GUI allow the user to turn these switches ON (selected) and OFF (cleared).

WARNING 

Use caution when changing from these default settings to ensure that damage will not 

occur. The VINUVLO, VINOVLO and Output OV controls adjust the VINUVLO, VINOVLO 

and OVREFCON registers, respectively.
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